MindManager

Large-Scale Deployment Guide
## CONTENTS

- List of Tables .................................................................................................................................. iv
- About This Guide ................................................................................................................................. v
  - MindManager Support Help ............................................................................................................... v
- System Requirements for MindManager Installation ........................................................................ 1
- Understanding Deployment Strategies ................................................................................................. 2
  - Running the Standard Setup Manually or Automatically ............................................................... 2
  - Running the Admin Setup Manually or Automatically ............................................................... 2
  - Other Deployment Options ............................................................................................................. 3
    - Deploying with Active Directory ................................................................................................. 3
    - Deploying with Windows Server ................................................................................................. 3
    - Deploying with Citrix Presentation Server ............................................................................... 3
    - Using System Management Software and a Custom Setup .................................................. 3
    - Deploying on a Shared Network Drive ....................................................................................... 3
- What Gets Installed ............................................................................................................................. 4
  - MindManager Components ........................................................................................................... 4
    - Library ......................................................................................................................................... 4
    - Dictionaries ................................................................................................................................. 5
    - Tutorials ......................................................................................................................................... 5
    - User Configuration Files ........................................................................................................... 5
  - Shortcuts and Start Menu Items ........................................................................................................ 6
  - Shared System Software .................................................................................................................... 6
  - Third-Party Software ....................................................................................................................... 7
    - ThirdPartyReadMe ......................................................................................................................... 9
  - Registry Keys ..................................................................................................................................... 9
- What Remains After Uninstallation ..................................................................................................... 12
  - Remaining Files, Folders, and Software Components .................................................................. 12
  - Remaining Registry Keys .............................................................................................................. 13
- Using the Admin Setup ....................................................................................................................... 14
  - Required Software ......................................................................................................................... 15
Required Permissions and Privileges ........................................................................................................ 15
Differences between the Standard and Admin Setups .............................................................................. 16
Installing MindManager: An Overview ...................................................................................................... 16
  Per-machine Setup .................................................................................................................................. 16
  Per-user Setup ....................................................................................................................................... 16
Deploying with the Installation Wizard ....................................................................................................... 18
  Starting the Installation ............................................................................................................................. 18
  Customizing the Installation ....................................................................................................................... 19
    Disabling Default Features ..................................................................................................................... 19
    Changing the Default Installation Folder ............................................................................................... 20
    Deploying User Data and the Library to a Server .................................................................................... 20
  Completing the Installation ....................................................................................................................... 22
Deploying from the Command Line ............................................................................................................. 24
  Configuring Installation Parameters from the Command Line ................................................................. 24
  Configuring Features from the Command Line ........................................................................................... 25
    Customizing the Installation with Setup.exe .......................................................................................... 25
    Customizing the Installation with MSI .................................................................................................. 25
  Configuring Functions from the Command Line ....................................................................................... 27
  Configuring Functions from the Registry .................................................................................................. 28
  Deploying User Data and the Library ......................................................................................................... 30
    Deploying User Data and the Library from the Command Line ................................................................. 30
    Deploying User Data from the Registry .................................................................................................. 31
  Sample Setup Commands ......................................................................................................................... 32
    Simple Installation ................................................................................................................................. 32
    Silent Installation ................................................................................................................................. 32
    Sample Customized Installation Using ADDLOCAL and REMOVE ......................................................... 33
  Uninstallation ......................................................................................................................................... 33
Deploying with Active Directory .................................................................................................................. 34
Deploying with Windows Server .................................................................................................................. 36
Deploying with Citrix Presentation Server .................................................................................................. 37
  Basic Installation for the Citrix Desktop ................................................................................................... 37
  Advanced Installation of a “Seamless” Window ......................................................................................... 37
Administering MindManager ....................................................................................................................... 43
  Managing Add-Ins ................................................................................................................................. 43
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Registering or Unregistering Add-Ins from the Command Line</td>
<td>43</td>
</tr>
<tr>
<td>Managing Add-Ins from the Registry</td>
<td>43</td>
</tr>
<tr>
<td>The Registry Add-In List</td>
<td>43</td>
</tr>
<tr>
<td>Removing or Restoring Add-Ins from the Registry</td>
<td>43</td>
</tr>
<tr>
<td>Enabling or Disabling Add-Ins from the Registry</td>
<td>44</td>
</tr>
<tr>
<td>Managing Microsoft Office Add-Ins</td>
<td>44</td>
</tr>
<tr>
<td>Managing from the Registry</td>
<td>45</td>
</tr>
<tr>
<td>HKEY_LOCAL_MACHINE Settings</td>
<td>45</td>
</tr>
<tr>
<td>HKEY_CURRENT_USER Settings</td>
<td>46</td>
</tr>
<tr>
<td>Managing with Event Macros</td>
<td>47</td>
</tr>
<tr>
<td>Managing User Licenses</td>
<td>49</td>
</tr>
<tr>
<td>Policies Support</td>
<td>49</td>
</tr>
<tr>
<td>MindManager Linker for SharePoint</td>
<td>49</td>
</tr>
<tr>
<td>Index</td>
<td>52</td>
</tr>
</tbody>
</table>
LIST OF TABLES

Table 1: System Requirements........................................................................................................... 1
Table 2: Configuration Files................................................................................................................ 5
Table 3: Location of Shared System Components.............................................................................. 6
Table 4: Third-Party Software Overview............................................................................................ 7
Table 5: Registry Key Overview ......................................................................................................... 9
Table 6: Remaining Files, Folders, and Software components.......................................................... 12
Table 7: Remaining Registry Keys ..................................................................................................... 13
Table 8: Configuring Installation Parameters from the Command Line ............................................. 24
Table 9: Configuring Features with MSI from the Command Line .................................................... 26
Table 10: Configuring Functions from the Command Line ................................................................. 27
Table 11: Configuring Functions from the Registry ........................................................................... 29
Table 12: User Data Deployment Options .......................................................................................... 30
Table 13: Library Deployment Options ............................................................................................... 31
Table 14: User Data Registry Key Values ........................................................................................... 31
Table 15: Properties Editable in Properties Table ............................................................................. 34
Table 16: HKEY_LOCAL_MACHINE Registration Values .................................................................. 45
Table 17: HKEY_LOCAL_MACHINE Settings ..................................................................................... 45
Table 18: HKEY_CURRENT_USER Settings ......................................................................................... 46
Table 19: Event Macros ....................................................................................................................... 47
ABOUT THIS GUIDE

Many customers have requested support for customized deployment of MindManager to large numbers of client machines. This document provides complete information about large-scale deployments.

Topics include:

- Running the standard setup manually or automatically (page 2)
- Running the admin setup manually or automatically (page 2)
- MindManager components (page 4)
- Deploying using the installation wizard (page 18)
- Deploying from the command line (page 24)
- Deploying with Windows Active Directory (limited support) (page 34)
- Deploying with Windows Server running Terminal Services (page 36)
- Deploying with Citrix Presentation Server (page 37)

Note: Installing MindManager on a Shared network Drive is not supported.

Note: To use MindManager with Microsoft SharePoint, you must purchase and install MindManager Enterprise.

MindManager Support Help

For technical support with this product, go to http://www.mindjet.com/support. Here you will find links to the Knowledge Base articles, User Forums, and other online resources. You can also submit a support request for additional assistance.
# System Requirements for MindManager Installation

## Table 1: Installation Requirements

<table>
<thead>
<tr>
<th>Requirements</th>
<th>Supported Operating Systems</th>
<th>Additional Requirements to Use Certain Features</th>
</tr>
</thead>
</table>
| IBM® or compatible Pentium® processor (1 GHz or greater) | **Microsoft® Windows® 8 and 8.1 32-bit and 64-bit**<sup>*</sup>  
**Microsoft® Windows® 7 and 7.1 32-bit and 64-bit**<sup>*</sup> (includes Service Pack 1 released in Feb, 2011) | **Microsoft Office Professional 2003, 2007, 2010, or 2013 (32-bit and 64-bit)**  
**Microsoft SharePoint 2010 Enterprise, Standard and Foundation servers** *  
**Mozilla® Firefox® 9.0 or greater**  
**Google Chrome™ 16.0 or greater**  
**Adobe® Acrobat® 9.2 or greater**  
**Adobe Flash® Player 10 or greater**  
**Broadband Internet Connection** |
| 2 GB RAM or greater                  | **Microsoft Windows Server 2008 R2 64-bit and later**  
**Microsoft Windows Server® 2003 32-bit** |                                                                                                                   |
| 830 MB disk space                    | **Citrix MetaFrame Presentation Server 4.5 and above (e.g. 5.0)**  
**Citrix XenApp Version 6**  
**Microsoft Windows Server 2008 R2 64-bit and later**  
**Microsoft Windows Server® 2003 32-bit** |                                                                                                                   |
| SVGA (1024 x 768/16-bit color or greater) | **Microsoft Office Professional 2003, 2007, 2010, or 2013 (32-bit and 64-bit)**  
**Microsoft SharePoint 2010 Enterprise, Standard and Foundation servers** *  
**Mozilla® Firefox® 9.0 or greater**  
**Google Chrome™ 16.0 or greater**  
**Adobe® Acrobat® 9.2 or greater**  
**Adobe Flash® Player 10 or greater**  
**Broadband Internet Connection** |                                                                                                                   |
| Microsoft .NET 4.0 or higher         | **Microsoft Office Professional 2003, 2007, 2010, or 2013 (32-bit and 64-bit)**  
**Microsoft SharePoint 2010 Enterprise, Standard and Foundation servers** *  
**Mozilla® Firefox® 9.0 or greater**  
**Google Chrome™ 16.0 or greater**  
**Adobe® Acrobat® 9.2 or greater**  
**Adobe Flash® Player 10 or greater**  
**Broadband Internet Connection** |                                                                                                                   |

Large Scale Deployments

- **Citrix MetaFrame Presentation Server 4.5 and above (e.g. 5.0)**  
- **Citrix XenApp Version 6**  
- **Microsoft Windows Server 2008 R2 64-bit and later**  
- **Microsoft Windows Server® 2003 32-bit**

*To use MindManager with Microsoft SharePoint, you must purchase and install MindManager Enterprise.*

If deploying MindManager in a terminal server environment, the following are prerequisites:

- Windows Server 2008 running Terminal Services
  
or

- Citrix MetaFrame Presentation Server 4.5 and above 32-bit, or XenApp 6 64-bit

Using this method, each client machine must also meet the software and hardware requirements. When running MindManager on a terminal server, the client must be able to connect and handle RDP. The server requirements depend on the number of clients.
UNDERSTANDING DEPLOYMENT STRATEGIES

This section provides an overview of different deployment strategies, including their basic technologies, advantages, limitations, and their level of support.

Running the Standard Setup Manually or Automatically

You can deploy MindManager on a machine-by-machine basis using the standard setup (MindManager.exe) by installing from the physical CD, or from a centrally accessible server. The standard setup is robust, interactive, and user-friendly, but does not support customized deployment.

Using the standard setup has these advantages:

- MindManager installs and operates properly on supported systems
- It requires no additional software or server resources
- Users with local administration privileges can manage the update process individually

And these disadvantages:

- Manual installation is time-consuming
- The installed software uses up disk space on each user's system
- Centralized administration becomes more difficult

Running the Admin Setup Manually or Automatically

The MindManager Admin setup provides more control over installation and administration. You can run the admin setup from a server manually, or via a log-on script. If you use Windows Active Directory, Group Policy, and IntelliMirror, you can install on groups of user systems.

Using the admin setup has these advantages:

- MindManager installs and operates properly on supported systems
- It requires no additional software or server resources
- You can customize installations on a per-group or per-user basis
- You can run the installation silently
- The installer is not cached on the client machine, reducing the required disk space

And these disadvantages:

- Access to the original installer is required for repair and other setup operations
Other Deployment Options

Deploying with Active Directory
This method is not yet fully supported. Due to the application architecture, MindManager only supports Computer-based Software installations via Active Directory. **User-based deployment is not supported.** Using a third party tool such as Orca allows you to edit properties for deployment. For more information, see *Deploying with Active Directory*, page 34.

Deploying with Windows Server
Deploying MindManager from a terminal server to a thin client is another supported option. With this architecture, it is possible (for example), to "run" a Windows application on a Windows client machine, where one server services many clients. You need to deploy MindManager using Windows Server Terminal Services to use full color mode in MindManager. For more information, see *Deploying with Windows Server*, page 36.

Deploying with Citrix Presentation Server
The Citrix MetaFrame Presentation Server is a sophisticated terminal server environment built on top of the Windows Terminal Services provided by Windows Server. This is currently the only tested and supported Citrix platform for MindManager (although other combinations may work). For more information, see *Deploying with Citrix Presentation Server*, page 37.

Using System Management Software and a Custom Setup
System management software, such as Microsoft System Management Server, enables you to centrally install and administer client machines. While you can deploy MindManager using such software, there is no specialized support for this in MindManager. This document supplies much of the information you will need if you choose to deploy in this way.

Using system management software has these advantages:
- You can deploy the software to many machines with one command
- You can create different setups for different groups of users
- Updating the software is simple

And these disadvantages:
- You must have system management software in place
- It takes time to create the custom setup
- The installed software uses up disk space on each user's system

Deploying on a Shared Network Drive
MindManager does not support installing on a shared network drive and having users run it directly from there.
WHAT GETS INSTALLED

The Admin setup installs:

- Required program files
- Configurable components
- Shortcuts and Start Menu items
- Third-party add-ins or components
- Shared system software
- Registry keys

The default location for required program files is:

```plaintext
C:\Program Files\Mindjet\MindManager 15
```

This folder contains `MindManager.exe`, application DLLs, and third party components. No user files are stored in this folder.

MindManager uses merge modules to install required system software, such as `ATL80.dll`. If MindManager uses a later version of a component than one already installed on the machine, MindManager installs the required version during deployment. For more information, see Shared System Software, below.

The first time a user runs the application, user data is placed in the default location `C:\Documents and Settings\UserName\Local Settings\Application Data\Mindjet\MindManager\15`, where `UserName` is the current user name. You must enable viewing hidden files to see this directory. Note: This will be different on XP versus newer versions of Windows, but the principle is the same.

The first time a user starts the application, the application also searches to determine if a Microsoft Office custom dictionary exists for that user (e.g. “C:\Documents and Settings\UserName\Application Data\Microsoft\Proof\CUSTOM.DIC”). If the user-specific Microsoft Office custom dictionary is found, a reference to that dictionary is added to the list of spelling dictionaries.

MindManager stores maps at this default location:

```plaintext
C:\Documents and Settings\UserName\My Documents\My Maps
```

MindManager Components

The application installs a variety of configurable components, including:

- Library
- Dictionary
- Tutorials

User configuration files are also installed to help govern their behavior.

Library

The Library component consists of two sub-components: Images and the Template Organizer. These are optional but highly recommended components.
• Images are a library of pictures used to help make maps more memorable.
• The Template Organizer contains a variety of map and web templates.

The library is not uninstalled if you uninstall the application; this content is preserved for users upgrading to newer versions.

The default location for the Library is:

C:\Documents and Settings\<username>\Local Settings\Application Data\Mindjet\MindManager\15\Library\<language version>

You may wish to install the library to a different location. See the documentation for deploying with the Installation Wizard (page 18) or from the command line (page 24) for instructions.

Dictionaries

The Dictionaries component contains spell check dictionaries available, including dictionaries for over 10 languages. When using the installer, you can choose which dictionaries to install. You can also control dictionary installation from the command line.

Dictionaries are not removed during the uninstall process; this content is preserved for users upgrading to newer versions of the application.

The default location for Dictionaries is:

C:\Documents and Settings\<username>\Local Settings\Application Data\Mindjet\MindManager\15\Spell

Tutorials

By default, all tutorials are installed. The default location for local tutorials is:

C:\Program Files\Mindjet\MindManager 15\<language version>

You can customize your tutorial installation by choosing:

• To deploy them to a server, rather than installing them on local machines
  or
• To not deploy tutorials at all

User Configuration Files

MindManager creates and stores user configuration files for different purposes.

Table 2: Configuration Files

<table>
<thead>
<tr>
<th>FILE NAME</th>
<th>LOCATION AND FUNCTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>ImagePropertyDatabase.dat</td>
<td>C:\Documents and Settings&lt;username&gt;\Local Settings\Application Data\Mindjet\MindManager\15</td>
</tr>
<tr>
<td></td>
<td>The application runtime, not the installer, creates this file dynamically. It collects information about keywords assigned by the user to images.</td>
</tr>
<tr>
<td>UserData.ini</td>
<td>C:\Documents and Settings&lt;username&gt;\Local Settings\Application Data\Mindjet\</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**FILE NAME** | **LOCATION AND FUNCTION**
--- | ---
Library.ini | C:\Documents and Settings\<username>\Local Settings\Application Data\Mindjet\MindManager\15\Library\<language version>

This file detects the library installation time. Because the application installs the library the first time it is launched, this file prevents multiple library installations.

### Shortcuts and Start Menu Items

The installer puts a shortcut to the program on the Windows Desktop, the Windows Send To menu and in the main Start menu. It creates a Mindjet folder in the Start >Programs folder with a shortcut to MindManager in it.

The MindManager shortcut is an “advertised shortcut” to the program that automatically checks to determine if the program needs to be repaired before it is run. If a repair is needed, it is performed then. If you do not want to use this self-repairing feature, you can create a shortcut directly to the MindManager.exe file instead. Deleting this copy of the installer disables the self-repair service as well.

### Shared System Software

Some shared software must be installed on your system before using the admin setup. During installation, MindManager uses merge modules to install other missing software, such as PIPanel.msm. Missing components are installed from the modules. Depending on the host machine’s configuration, the merge module installs the components required for that machine.

These shared components are not uninstalled automatically. Their default locations are indicated below.

### Table 3: Location of Shared System Components

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>FOLDERS AND FILES</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ink related files</td>
<td>%CommonProgramFiles%\Microsoft Shared\Ink</td>
</tr>
<tr>
<td></td>
<td>• InkObj.dll</td>
</tr>
<tr>
<td></td>
<td>• tpcps.dll</td>
</tr>
<tr>
<td></td>
<td>• PIPanel.exe*</td>
</tr>
<tr>
<td></td>
<td>• PIPanel.dll*</td>
</tr>
<tr>
<td></td>
<td>• GdiPlus.dll</td>
</tr>
<tr>
<td></td>
<td>%WINDIR%\system32</td>
</tr>
<tr>
<td></td>
<td>• InkEd.dll</td>
</tr>
<tr>
<td></td>
<td>• PipRes.dll*</td>
</tr>
<tr>
<td></td>
<td>• wisptis.exe</td>
</tr>
</tbody>
</table>
These components are installed only on Tablet PCs.

C++ runtime libraries

- %WINDIR%\system32
  - msvcp60.dll
  - msvcp80.dll

For a complete list of these merge modules’ components, see Microsoft’s documentation.

Environment variable names (e.g. “%CommonProgramFiles%”) are expanded to their actual values (e.g. “C:\Program Files\Common Files”) by the installer.

### Third-Party Software

MindManager uses specific third-party software. Unless otherwise stated, the installer checks to learn if the component is present on the system. If not, or if the application uses a newer version, the application installs or updates the software. The setup process places third-party software at `C:\Program Files\Mindjet\MindManager 15`, and removes during the application uninstall process.

#### Table 4: Third-Party Software Overview

<table>
<thead>
<tr>
<th>Third-Party Software</th>
<th>Description and Vendor</th>
</tr>
</thead>
<tbody>
<tr>
<td>adfactry.dll</td>
<td>Active Delivery Factory is a self-extracting zip executable</td>
</tr>
<tr>
<td></td>
<td>Inner Media, Inc.</td>
</tr>
<tr>
<td>atl70.dll</td>
<td>Active Template Library, template-based C++ classes, creates COM objects</td>
</tr>
<tr>
<td></td>
<td>Microsoft</td>
</tr>
<tr>
<td>BCGCBPRO2100u.dll</td>
<td>BCG Control Bar Professional DLL</td>
</tr>
<tr>
<td>BCGPStyle2010Black210.dll</td>
<td>BCGSoft Ltd. Portions</td>
</tr>
<tr>
<td>BCGPStyle2010Blue210.dll</td>
<td></td>
</tr>
<tr>
<td>BCGPStyle2010White210.dll</td>
<td></td>
</tr>
<tr>
<td>Blowfish algorithm</td>
<td>128-bit encryption for password protection</td>
</tr>
<tr>
<td></td>
<td>Schneier Publishing</td>
</tr>
<tr>
<td>ChartFX.ClientServer.core.dll</td>
<td>Chart FX Client Server ActiveX Control is used with spreadsheet to create bar charts</td>
</tr>
<tr>
<td></td>
<td>Software FX, Inc.</td>
</tr>
<tr>
<td>dunzip32.dll</td>
<td>DynaZIP-32 Multi-Threading UnZIP DLL</td>
</tr>
<tr>
<td></td>
<td>Inner Media, Inc.</td>
</tr>
<tr>
<td>dzip32.dll</td>
<td>DynaZIP-32 Multi-Threading ZIP DLL</td>
</tr>
<tr>
<td></td>
<td>Inner Media, Inc.</td>
</tr>
<tr>
<td>axinterop.officeviewermme.dll</td>
<td>Base Office Viewer used by embedded Browser</td>
</tr>
<tr>
<td>interop.officeviewermme.dll</td>
<td>EDrawSoft</td>
</tr>
<tr>
<td>THIRD-PARTY SOFTWARE</td>
<td>DESCRIPTION AND VENDOR</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>officeviewermme.ocx</td>
<td></td>
</tr>
<tr>
<td>extensibility.dll</td>
<td>Allows addition of add-ins</td>
</tr>
<tr>
<td>gdiplus.dll</td>
<td>GDI+ is a C/C++ API that supports integrating graphics and images on both the video display and printer</td>
</tr>
<tr>
<td>HTS32MM.dll</td>
<td>An HTML control that supports inserting pictures, hyperlinks, tables, and other objects into RTF text</td>
</tr>
<tr>
<td>Independentsoft.Webdav.dll</td>
<td>WebDAV protocol client API for .NET Framework</td>
</tr>
<tr>
<td>libtidyU.dll</td>
<td>HTML Tidy fixes a variety of HTML issues</td>
</tr>
<tr>
<td>interop.msscriptcontrol.dll</td>
<td>Parses the XML returned by the Web Services</td>
</tr>
<tr>
<td>msscript.ocx</td>
<td></td>
</tr>
<tr>
<td>matrix.dll</td>
<td>Map co-editing engine</td>
</tr>
<tr>
<td>Microsoft .NET Framework</td>
<td>Microsoft Web Services Enhancements 4.0 for Microsoft Windows Communication Foundation</td>
</tr>
<tr>
<td>Mfc80.dll</td>
<td>Microsoft Foundation Classes, wrap Windows APIs in C++ libraries, forming application framework</td>
</tr>
<tr>
<td>msvcp70.dll</td>
<td>Microsoft C++ Runtime Library</td>
</tr>
<tr>
<td>redemption.dll</td>
<td>Supports Microsoft Outlook Integration</td>
</tr>
<tr>
<td>Sax Basic Engine</td>
<td>Components that enable VB-like scripting</td>
</tr>
<tr>
<td>ww10_000.chm</td>
<td>Support WinWrapBasic from Polar Engineering</td>
</tr>
<tr>
<td>ww10_32w.dll</td>
<td></td>
</tr>
<tr>
<td>Sfxbe322.dll</td>
<td>A 32-bit active delivery self-extracting, back-end zip executable.</td>
</tr>
<tr>
<td>Sfxfe32.exe</td>
<td>A 32-bit active delivery self-extracting, front-end zip executable.</td>
</tr>
<tr>
<td>Spr32du70.dll</td>
<td>FarPoint Spreadsheet Control</td>
</tr>
</tbody>
</table>
### Third-Party Software Description and Vendor

<table>
<thead>
<tr>
<th>SOFTWARE</th>
<th>DESCRIPTION AND VENDOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ssce5532.dll</td>
<td>▪ FarPoint Technologies, Inc.</td>
</tr>
<tr>
<td></td>
<td>▪ Spell checker engine</td>
</tr>
<tr>
<td></td>
<td>▪ Wintertree Software, Inc.</td>
</tr>
<tr>
<td>TER32MM.DLL</td>
<td>▪ RTF edit control</td>
</tr>
<tr>
<td></td>
<td>▪ Sub Systems, Inc.</td>
</tr>
<tr>
<td>Vic32.dll</td>
<td>▪ Image processor</td>
</tr>
<tr>
<td></td>
<td>▪ Catenary Systems, Inc.</td>
</tr>
<tr>
<td>vsflex8n.ocx</td>
<td>▪ VSFlexGrid8 (Unicode) helps display, edit, and format tabular data in spreadsheets. Helps integrate with Microsoft Excel.</td>
</tr>
<tr>
<td></td>
<td>▪ ComponentOne</td>
</tr>
<tr>
<td>zlib.dll</td>
<td>▪ Lossless data compression library</td>
</tr>
<tr>
<td>zlib64.dll</td>
<td>▪ Jean-Loup Gailly and Mark Adler</td>
</tr>
</tbody>
</table>

### ThirdPartyReadMe

See the link below for additional legal information regarding Mindjet’s use of third-party software:


### Registry Keys

The installer places any per-machine Mindjet registry settings in or below the key:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15

These are the settings used by the application and its add-ins on a per-machine basis. No per-user values are stored in this key.

Following Windows guidelines, the application registers its associated file types, COM objects, etc., in sub-keys of HKEY_CLASSES_ROOT.

### Table 5: Registry Key Overview

<table>
<thead>
<tr>
<th>KEY TYPE</th>
<th>LOCATION/KEY</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_LOCAL_MACHINE</td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15</td>
</tr>
<tr>
<td>HKEY_CLASSES_ROOT</td>
<td>HKEY_CLASSES_ROOT...(all keys below this level)</td>
</tr>
<tr>
<td></td>
<td>▪ .mmap</td>
</tr>
<tr>
<td></td>
<td>▪ .mmas</td>
</tr>
<tr>
<td></td>
<td>▪ .mmat</td>
</tr>
<tr>
<td></td>
<td>▪ .mmbas</td>
</tr>
<tr>
<td></td>
<td>▪ .mmmp</td>
</tr>
<tr>
<td></td>
<td>▪ .mmms</td>
</tr>
<tr>
<td></td>
<td>▪ .mmp</td>
</tr>
<tr>
<td>Key Type</td>
<td>Location/Key</td>
</tr>
<tr>
<td>----------</td>
<td>--------------</td>
</tr>
<tr>
<td>Mindjet.MindManager.Document.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MindManager.Document.Template.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MindManager.Macro.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MindManager.MapMarker.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MindManager.MapMarkerSet.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MindManager.MapPart.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MindManager.Style.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM5GenericSmartMapPart.AddIn</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM5GenericSmartMapPart.AddIn.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM5Sort.AddIn</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM5Sort.AddIn.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM5WebExportAddIn</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM5WebExportAddIn.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM10ExcelLinker.AddIn</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM10ExcelLinker.AddIn.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM10MsProject.AddIn</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM10MsProject.AddIn.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM10Outlook.AddIn</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM10Outlook.AddIn.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM10OutlookLinker.AddIn</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM10OutlookLinker.AddIn.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM10PPExport.AddIn</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM10PPExport.AddIn.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM10Project.AddIn</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM10Project.AddIn.x</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM10Word.AddIn</td>
<td></td>
</tr>
<tr>
<td>Mindjet.MM10Word.AddIn.x</td>
<td></td>
</tr>
<tr>
<td>MindManager.Application</td>
<td></td>
</tr>
<tr>
<td>MindManager.Application.x</td>
<td></td>
</tr>
<tr>
<td>MindManager.Color</td>
<td></td>
</tr>
<tr>
<td>MindManager.Color.x</td>
<td></td>
</tr>
<tr>
<td>MindManager.TextFont</td>
<td></td>
</tr>
<tr>
<td>MindManager.TextFont.x</td>
<td></td>
</tr>
<tr>
<td>Mm5WebExport.Page</td>
<td></td>
</tr>
<tr>
<td>Mm5WebExport.Page.x</td>
<td></td>
</tr>
<tr>
<td>Mm5WebExport.Pages</td>
<td></td>
</tr>
<tr>
<td>Mm5WebExport.Pages.x</td>
<td></td>
</tr>
<tr>
<td>Mm5WebExport.VariantSets</td>
<td></td>
</tr>
<tr>
<td>Mm5WebExport.VariantSets.x</td>
<td></td>
</tr>
<tr>
<td>Mm5WebExport.WebExport</td>
<td></td>
</tr>
<tr>
<td>Mm5WebExport.WebExport.x</td>
<td></td>
</tr>
<tr>
<td>Mm5WebExport.WebExports</td>
<td></td>
</tr>
<tr>
<td>Mm5WebExport.WebExports.x</td>
<td></td>
</tr>
<tr>
<td>MM8InternetExplorer.BHO</td>
<td></td>
</tr>
<tr>
<td>MM8InternetExplorer.BHO.x</td>
<td></td>
</tr>
</tbody>
</table>

Uninstall Key: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall

HKEY_CURRENT_USER: HKEY_CURRENT_USER\Software\Mindjet\MindManager\15

Uninstall information for the program is stored in a sub-key of:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall

The name of the sub-key is the Globally Unique Identifier (GUID) for the program (which changes with each release). You can find it by using RegEdit to search for “MindManager” in the Uninstall key. The uninstallation key does not remain after uninstalling.

When a user runs the application, any per-user registry settings are stored in or below the key:

HKEY_CURRENT_USER\Software\Mindjet\MindManager\15

Some Current User keys remain after uninstalling. These keys help preserve user data for upgrading to the next version of MindManager.
WHAT REMAINS AFTER UNINSTALLATION

When you uninstall, almost all traces of the application are removed, including all components located at C:\Program Files\Mindjet\MindManager 15. Most registry keys are removed as well. Map files (.mmp and .mmap files) are not deleted.

On Microsoft Windows 7 or any other system where the system administrator has disallowed the use of RegEdit to export the registry key (i.e. DisableRegistryTools is set), the registry key is backed up to a MindManager registry subkey under:

HKCU\Software\Mindjet\MindManager\MMX15 RegistryBackup_<date>_ <time>.

Some the remnants of the application are left behind. These are needed to preserve user data when upgrading to a newer version. See Remaining Files, Folders, and Software Components (page 13) and Remaining Registry keys (page 13) for more information.

Remaining Files, Folders, and Software Components

When you uninstall, the installer leaves behind some components it installed with the program. The tables below reflect the most common remaining components and registry keys. The actual list may vary depending upon the installation and deployment. In general, components left behind fit one of these scenarios:

- User data (the library, images, and templates) remains to support upgrading to the next version or
- Shared components, such as C++ libraries, and their registry keys get left behind because they may be required for other purposes
  - or
- A backup of your registry

<table>
<thead>
<tr>
<th>COMPONENT</th>
<th>LOCATION AND EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>C++ runtime libraries</td>
<td>See Shared System Software (page 6) for locations. &lt;br&gt;These files may be in use by other applications.</td>
</tr>
<tr>
<td>Ink related files</td>
<td>See Shared System Software (page 6) for locations. &lt;br&gt;These files may be in use by other applications.</td>
</tr>
<tr>
<td>MMX14RegistryBackup_&lt;date&gt;_ &lt;time&gt;</td>
<td>C:\MyDocuments\ &lt;br&gt;Opening this file gives you the option to add its contents to your current registry.</td>
</tr>
<tr>
<td>msvcp60.dll</td>
<td>%WINDIR%\system32</td>
</tr>
<tr>
<td>COMPONENT</td>
<td>LOCATION AND EXPLANATION</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>msvcrtd.dll</td>
<td>%WINDIR%\system32 This software may be in use by other applications.</td>
</tr>
<tr>
<td>XML-related files</td>
<td>See Shared System Software (page 6) for locations. These files may be in use by other applications.</td>
</tr>
<tr>
<td>User Data</td>
<td>C:\Documents and Settings&lt;local user&gt;\Local Settings\Application Data\Mindjet\MindManager\15 Contains dictionaries, images, templates dictionaries etc. that the user may have customized. Does not uninstall so the user does not lose this data when upgrading.</td>
</tr>
</tbody>
</table>

### Remaining Registry Keys

Some registry keys remain after uninstallation. A backup copy of your registry is placed at:

C:\My Documents\MMX15RegistryBackup_<date>_<time>

<table>
<thead>
<tr>
<th>REGISTRY KEY</th>
<th>LOCATION AND EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_CLASSES_ROOT</td>
<td>HKEY_CLASSES_ROOT\</td>
</tr>
<tr>
<td></td>
<td>• .mmap</td>
</tr>
<tr>
<td></td>
<td>• .mmp</td>
</tr>
<tr>
<td></td>
<td>These keys register .mmap file extensions.</td>
</tr>
<tr>
<td>HKEY_CURRENT_USER</td>
<td>HKEY_CURRENT_USER\Software\Mindjet\MindManager\15\</td>
</tr>
<tr>
<td></td>
<td>Keys at or below this preserve user data for upgrading.</td>
</tr>
</tbody>
</table>
USING THE ADMIN SETUP

The Admin setup gives systems administrators more control over an installation. It is distributed in a .zip archive that contains the following files:

- **MindManager Admin.msi**
  The MindManager Microsoft installer.

- **dotNetFx40_Full_setup.exe**
  Microsoft's .NET Framework redistributable setup.

- **instmsi30.exe**
  Microsoft Windows Installer engine setup. (Normally already on the target system.)

- **msxml6_x86.msi**
  The MSXML 6.0 installer.

- **vcredist_2005_sp1_x86.exe**
- **vcredist_2010_sp1_x86.exe**
- **vcredist_2010_sp1_x64.exe**
  Microsoft Visual C++ run-time environments for versions 2005 and 2010 (including 2010 for 64-bit machines.)

- **MindManager_Large_Scale_Deployment_Guide.pdf**
  This Deployment Guide.

Using the admin setup gives you nearly complete control over your deployment, including:

- Deploying (or not deploying) specific components
- Disabling functions, such as internet access
- Storing components on network drives, such as user data or the library

You also have the option of configuring many items from the registry.
Required Software

All required software is included in the Admin setup package. It contains some software that must be installed on your system before using the setup. You should verify that this software is already installed on your system; if not, install it from the admin package.

- **vcredist_2005_sp1_x86.exe** installs the VC++ Redistributable components for Visual Studio 2005.
  Check for existence of registry key:
  `HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\{7299052b-02a4-4627-81f2-1818da5d550d}
  Or simply re-install.

- **vcredist_2010_sp1_x86.exe** installs the VC++ Redistributable components for Visual Studio 2010.
  Check for existence of registry key:
  `HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\{F0C3E5D1-1ADE-321E-8167-68EF0DE699A5}
  Or simply re-install.

- **vcredist_2010_sp1_x64.exe** installs the VC++ Redistributable 64-bit components for Visual Studio 2010. *Only for 64bit machines.*
  Check for existence of registry key:
  `HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\{1D8E6291-B0D5-35EC-8441-6616F567A0F7}
  Or simply re-install.

- **msxml6_x86.msi** installs the MSXML 6.0 SP1 Parser
  Check the installed programs in the Control Panel to check existing installation.

- **dotNetFx40_Full_setup.exe** installs the Microsoft Net Framework
  Check the installed programs in the Control Panel to check existing installation. This install can take quite a long time.

**Note:** You should check for and install any missing components in the order listed above.

Required Permissions and Privileges

Administrator privileges are required to install any Windows software, including MindManager.
No special privileges or disk permissions are required to run the application. A user can run the program as a restricted user, a “normal” user, a power user, or an administrator. The program does assume that the user has read/write/create privileges in the HKEY_CURRENT_USER registry key as well as in the user profile section of the hard disk and below.

If a user does not have write privileges in the HKEY_LOCAL_MACHINE registry key, then:

- The Help/Check for Updates command is removed for that user, ensuring that they will not try to perform an upgrade that they are not authorized to do.

Differences between the Standard and Admin Setups

The Admin setup is based on the standard setup—with a number of important differences:

- **Caching**: The admin setup does not cache the setup on the computer where it is being installed. Instead, the setup should be run from a network location that remains accessible from the workstation at all times. This ensures proper operation of the Modify, Repair, and Remove entries in the “Add/Remove programs” Control Panel applet, and avoids duplication of the installation source on every system where the application is installed.

- **Patching**: Admin setups are only delivered as full setups, not patch setups. The reason for this is that system administrators might modify the admin setup to suit the needs of their individual company. If the installation database is transformed in this way, a future patch would not be able to properly update the installation. We avoid this problem by not delivering patch updates at all for our admin setups. To upgrade, you need to uninstall the previous version and install the upgrade.

- **Packaging**: We exclude the Microsoft Windows Installer engine and .NET Framework installer. Both components must be installed prior to running MindManager.msi if they are missing from a user’s machine.

- **User Data**: The admin setup includes the option to specify the location of user data.

- **Library Files**: There is also an option to have the application extract the library files as usual, or to have the administrator set this up “manually,” ahead of time. For more information, see Deploying User Data and the Library to a Server, page 20.

Installing MindManager: An Overview

This section gives an overview of the admin setup and application components. With this information, you can understand the installation process and determine what you may wish to customize for your deployment.

Per-machine Setup

The setup installs the program on a client machine and only sets per-machine registry settings in the HKEY_LOCAL_MACHINE and HKEY_CLASSES_ROOT registry keys. It does not directly create or set any registry keys or values in the HKEY_CURRENT_USER registry key.

The installer installs all program files to this default folder:

- C:\Program Files\Mindjet\MindManager 15

Administrator privileges are required to install any Windows software, including MindManager.

Per-user Setup
Each time the application launches, it checks the UserData.ini file, located in \Documents and Settings\<Username>\Local Settings\Application Data\Mindjet\MindManager\15 to determine if a per-user setup needs to be performed.

If this file is missing, or if the version of the application installed is newer than the version the user last ran, then MindManager prepares for a “new” per-user installation by deleting the following registry key:

HKEY_CURRENT_USER\Software\Mindjet\MindManager\15\User Interface

The application also determines if the per-user application data files (outline print templates and spell check auto-correct dictionaries) are present. If not, it copies them from the “All Users” folder:

C:\Documents and Settings\All Users\Application Data\Mindjet\MindManager\15

Finally, the application determines if the per-user Library files need to be installed using the same UserData.ini algorithm described above and checks the LSDLibraryExtract. If the registry is not set to 0, then a separate background task/program is run to unzip the library files from a MindManager sub-folder:

C:\Program Files\Mindjet\MindManager 15\sys\<language version>

The Vista system folder structure uses environmental variables instead of real paths. Note the different path structure below:

%USERPROFILE%\Local Setting\Application Data\Mindjet\MindManager\15
%ALLUSERPROFILE%\Application Data\Mindjet\MindManager\15
%ProgramFiles%\Mindjet\MindManager 15\sys\<language version>
DEPLOYING WITH THE INSTALLATION WIZARD

Using the admin setup to install the application is straightforward and simple. Unlike the basic setup, you have customization options, though not as many as from the command line.

Starting the Installation

To install the application:

1. Launch the installer.
2. At the welcome screen, click **Next**.
3. Select “I agree to the terms of the license agreement” and click **Next**.
4. Enter the Customer Information (User Name and Organization).
5. Click **Next**.

The Setup Type dialog appears.

At this point, you can customize your deployment or complete the installation (page 22).
Customizing the Installation

A custom installation allows you to:

- Disable default features
- Change the default installation folder
- Deploy user data and the library on a separate server

If you need to customize the installation beyond these parameters, see *Deploying from the Command Line* (page 24).

Disabling Default Features

To disable the default installation features:

6. Complete steps 1-5 in *Starting the Installation* (page 18).
7. Select Custom and click **Next**.
   **The Custom Setup dialog appears.**
8. In the tree, select a feature whose default installation you want to change.
9. Click the down arrow button 
10. Select the desired feature setting.

For each selected feature, a description and storage requirement appears.
11. Repeat this process until you have made all of your feature customization choices.
12. Complete the installation as outlined in *Completing the Installation* (page 22).
Changing the Default Installation Folder
To change the default installation folder:

13. Complete steps 1-5 in Starting the Installation (page 18).
14. Select Custom and click Next.

The Custom Setup dialog appears.

15. Click Change.

The Change Current Destination Folder dialog appears.
16. Select the destination folder.
17. Click OK.

The new destination folder appears in the Custom Setup dialog.
18. Complete the installation as outlined in Completing the Installation (page 22).

Deploying User Data and the Library to a Server
MindManager installs a “Library” folder containing:
- Background Images
- Icons
- Images
- Map Parts
- Shapes
- Styles
- Templates
- Web Export Templates

The entire library consists of several megabytes. By default, these files are stored on a per-user basis in this folder:

```
C:\Documents and Settings\UserName\Local Settings\Application Data\Mindjet\MindManager\15\Library\<language version>
```

where **UserName** is the current user's logon name.

You can store user data and the library in a network folder for if you wish to:

- Save space on users' systems
- Decrease the time required to run the program the first time
- Allow roaming user's access to their customized libraries
- Assure that all users have a fixed, easily updatable set of library files

You can install these files once to a common location (perhaps in a read-only folder). Multiple users can then share the files, or a single user can access them from multiple machines. If a user needs to edit these files, install them in a directory with write privileges.

You cannot install user data and the library to separate locations from the installation wizard. To install them separately, you must install them from the command line (page 24).

To deploy user data and the library to a server:

19. Complete steps 1-5 in *Starting the Installation* (page 18).

20. From the Custom Setup dialog, click **Advanced**.

   **The Deploy User Data Files dialog appears.**

21. Select Deploy user data on server.
22. Click **Browse**.

**The Browse for Folder dialog appears.**

23. Select the destination folder.

24. Click **OK**.

**The new directory appears in the Server base path field.**

25. Choose from the following options:

   - Extract library to the server path the first time MindManager starts
   - Use separate folders per user

We recommend selecting both of these options to avoid needing to configure the user data folder and the library folder separately. You may want to create the user folders before installation, giving you the chance to make the files read only.

26. Click **OK** to close the dialog.

27. Complete the installation as outlined in **Completing the Installation** (page 22).

These are all of the customization choices available from the installer interface. You have more control if you deploy from the command line (page 24).

---

**Completing the Installation**

To complete the standard installation:

28. Select Complete and click **Next**.
The Ready to Install dialog appears.

29. Choose your shortcut options.
30. Click **Install**.
31. After the installation is complete, choose from the following options:
   - Launch MindManager
   - Register MindManager
32. Click **Finish**.
DEPLOYING FROM THE COMMAND LINE

While you may wish to customize your deployment from the installer interface (page 19), you have much greater control over the installation from the command line, including:

- Configuring installation parameters (page 24)
- Specifying what to install on a feature by feature basis (page 25)
- Enabling or disabling program functions
- Specifying where to install libraries, and user data (page 30)
- Using a custom SharePoint SiteConnections.xml file (page 49) *

* To use MindManager with Microsoft SharePoint, you must purchase and install MindManager Enterprise.

This section identifies what you may configure and provides examples of command line arguments for customizing your deployment. A sample installation command demonstrating most of these options is included in Sample Setup Commands (page 32).

Configuring Installation Parameters from the Command Line

You can set a number of public properties with command line options.

Table 8: Configuring Installation Parameters from the Command Line

<table>
<thead>
<tr>
<th>PARAMETER</th>
<th>DESCRIPTION OF VALUES</th>
</tr>
</thead>
<tbody>
<tr>
<td>INSTALLDIR</td>
<td>Specifies where the application should install the program. For example:</td>
</tr>
<tr>
<td></td>
<td>&quot;C:\Program Files\Mindjet\MindManager 15&quot;</td>
</tr>
<tr>
<td>ISX_SERIALNUM</td>
<td>Specifies the license key for your installation. Note: No validation is performed for this key, it is simply written to the registry. If the license key is not valid, the application runs in a restricted (trial) mode.</td>
</tr>
<tr>
<td>USERNAME</td>
<td>Specifies the User Name for registering the application. Optional parameter; the Windows User Name will be used if this parameter is not supplied.</td>
</tr>
<tr>
<td>COMPANYNAME</td>
<td>Specifies the Company Name for registering the application. Optional parameter; the Windows Company Name will be used if this parameter is not supplied.</td>
</tr>
</tbody>
</table>
Configuring Features from the Command Line

The admin setup is a Basic MSI project, not an InstallScript project; there is no record mode to run an install with Setup.iss. Basic MSI projects do not create or use a response file for silent installations.

Tip: When configuring features from the command line, it is better to use /s silent installation to avoid conflicts with properties set through the installer interface. You can remove or add features from the command line by using ADDLOCAL or REMOVE on a feature by feature basis. To simplify the process, use ADDLOCAL="ALL" and then remove features you do not want. Examples are provided below.

Customizing the Installation with Setup.exe

You can use the following options to add or remove features from the command line setup.exe:

/\v=command line access to msi file
/\qn=when used with /\v parameter, silent (no user interface) parameter passed to msi file

Here are examples of adding and removing features through the setup.exe file, using silent install:

Adding:
<directory>\setup.exe  /\v"ADDLOCAL="MSWordAddin"" /\qn"

Removing:
<directory>\setup.exe  /\v"ADDLOCAL="ALL"" "REMOVE="MSWordAddin"" /\qn"

You can also string together multiple features for inclusion or removal:
<directory>\setup.exe
/\v"ADDLOCAL="All"" REMOVE="MSWordAddin,PDFWriter,RSS"" /\qn"

Customizing the Installation with MSI

You can use these options to add or remove features from the command line with MSI.exe:

/\i=install mode
/\qn=silent (no user interface) parameter (Tip: /\qn+ will let you know when it's done)

Note: On a VISTA system, security features require that you run silent install (/\qn) as the Administrator, not as a member of the Administrator group.

Here are examples of adding and removing features through the msiexec.exe file, using silent install:

Adding:
msiexec /i "<directory>\filename.msi" ADDLOCAL="MSWordAddin" /\qn

Removing:
msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL" REMOVE="MSWordAddin" /\qn

You can also string together multiple features for inclusion or removal:
msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL"
REMOVE="MSWordAddin,PDFWriter,RSS" /\qn
## Table 9: Configuring Features with MSI from the Command Line

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>COMMENTS</th>
</tr>
</thead>
</table>
| Library            | Available add-ins  
The default add-in is Library, which installs add-ins below. You can also specify a subset.  
- Images  
- Shapes  
- BackgroundImages  
- Icons  
- ImageGallery  
- Icons  
- TemplateOrganizer  
- Templates  
- WebTemplates  
- Styles  
- MapParts  
- Markers  

Example:

```msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL" REMOVE="WebTemplates" /qn```

| Dictionaries       | Available add-ins  
The default add-in is Dictionaries, which installs add-ins below. You can also specify a subset.  
- Swedish  
- Spanish  
- NorwegianB  
- BrazilianPortugese  
- Italian  
- Danish  
- Finnish  
- CanadianEnglish  
- USEnglish  
- UKEnglish  
- French  
- Dutch  
- German  

Example:

```msiexec /i "<directory>\filename.msi" ADDLOCAL="ALL" REMOVE="CanadianEnglish" /qn```

| Microsoft Add-Ins  | Available add-ins  
The MSAddins feature is a container for the following Microsoft-related add-ins. Any or all of these sub-features can be all installed by specifying them on the command line. (Examples below clarify this.)  
- MSWordAddin  
- MSOutlookLinkerAddin  

```
FEATURE

<table>
<thead>
<tr>
<th>Feature</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>MSOutlookMapMinderLinkerAddin</td>
<td></td>
</tr>
<tr>
<td>MSPowerPointAddin</td>
<td></td>
</tr>
<tr>
<td>MSProjectAddin</td>
<td></td>
</tr>
<tr>
<td>MSExcelLinkerAddin</td>
<td></td>
</tr>
<tr>
<td>MSIEAddin</td>
<td></td>
</tr>
</tbody>
</table>

Note:

This MSAddins feature, and all sub-features, can be removed with REMOVE=“MSAddins” but they cannot be added with ADDLOCAL=“MSAddins.”

Example:

There are three options for including a feature that's not installed:

1. Include the selected feature
2. Include the selected feature and all sub-features
3. Include the selected feature and then select sub-features individually

- Using ADDLOCAL=“MSAddins” is equivalent to (1) above. However, this causes no add-ins to be added since MSAddins is just a container for other add-ins, and they need to be specified.
- ADDLOCAL=“MSAddins, MSExcelLinkerAddin, MSIEAddin, MSOutlookLinkerAddin, MSPowerPointAddin, MSProjectAddin, MSWordAddin” is equivalent to (2) above.
- Using a subset of MSIEAddin, MSOutlookLinkerAddin, MSPowerPointAddin, MSProjectAddin, MSWordAddin is equivalent to (3) above.

RSS

The add-in is RSS

Example:

msiexec /i "<directory>\filename.msi" ADDLOCAL=“ALL" REMOVE="RSS" /qn

Configuring Functions from the Command Line

During installation, you can disable some functions by setting the value to “0.” For example:

msiexec /i "<directory>\Mindjet Admin.msi" /qn ONLINEHELP="0"

Table 10: Configuring Functions from the Command Line
<table>
<thead>
<tr>
<th>FUNCTIONS</th>
<th>EXAMPLES</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Macro Support</strong></td>
<td>The function name is MACROUI.</td>
</tr>
<tr>
<td></td>
<td>Example (msi):</td>
</tr>
<tr>
<td></td>
<td><code>msiexec /i &quot;&lt;directory&gt;\MindjetAdmin.msi&quot; /qn MACROUI=&quot;0&quot;</code></td>
</tr>
<tr>
<td><strong>Shortcuts</strong></td>
<td>The function names are:</td>
</tr>
<tr>
<td></td>
<td>- SHORTCUTDESKTOP</td>
</tr>
<tr>
<td></td>
<td>- SHORTCUTSTARTMENU</td>
</tr>
<tr>
<td></td>
<td>- SHORTCUTQUICKLAUNCH</td>
</tr>
<tr>
<td></td>
<td>Example:</td>
</tr>
<tr>
<td></td>
<td><code>msiexec /i &quot;&lt;directory&gt;\Mindjet Admin.msi&quot; /qn SHORTCUTSTARTMENU=&quot;0&quot;</code></td>
</tr>
<tr>
<td><strong>Internet Access</strong></td>
<td>The function name is INTERNETACCESS.</td>
</tr>
<tr>
<td></td>
<td>Example (msi):</td>
</tr>
<tr>
<td></td>
<td><code>msiexec /i &quot;&lt;directory&gt;\Mindjet Admin.msi&quot; /qn INTERNETACCESS=&quot;0&quot;</code></td>
</tr>
<tr>
<td></td>
<td>Example (setup.exe):</td>
</tr>
<tr>
<td></td>
<td><code>&lt;directory&gt;\setup.exe /s /v&quot;INTERNETACCESS=0 /qn&quot;</code></td>
</tr>
<tr>
<td><strong>Online Help</strong></td>
<td>The function name is ONLINEHELP.</td>
</tr>
<tr>
<td></td>
<td>Example (msi):</td>
</tr>
<tr>
<td></td>
<td><code>msiexec /i &quot;&lt;directory&gt;\Mindjet Admin.msi&quot; /qn ONLINEHELP=&quot;0&quot;</code></td>
</tr>
<tr>
<td></td>
<td>Example (setup.exe):</td>
</tr>
<tr>
<td></td>
<td><code>&lt;directory&gt;\setup.exe /s /v&quot;ONLINEHELP=0 /qn&quot;</code></td>
</tr>
<tr>
<td><strong>UI Customization</strong></td>
<td>The function name is UICUSTOMIZATION.</td>
</tr>
<tr>
<td></td>
<td>Example (msi):</td>
</tr>
<tr>
<td></td>
<td><code>msiexec /i &quot;&lt;directory&gt;\Mindjet Admin.msi&quot; /qn UICUSTOMIZATION=&quot;1&quot;</code></td>
</tr>
<tr>
<td></td>
<td>Example (setup.exe):</td>
</tr>
<tr>
<td></td>
<td><code>&lt;directory&gt;\setup.exe /s /v&quot;UICUSTOMIZATION=1 /qn&quot;</code></td>
</tr>
<tr>
<td><strong>Disable Attachments</strong></td>
<td>The function name is DISABLEATTACHMENTS</td>
</tr>
<tr>
<td></td>
<td>Example (msi):</td>
</tr>
<tr>
<td></td>
<td><code>msiexec.exe /i &quot;Mindjet Admin.msi&quot; DISABLEATTACHMENTS=1 /qn</code></td>
</tr>
</tbody>
</table>

### Configuring Functions from the Registry

The application supports configuring specific functionality in the registry before installing the application. The installer reads these keys and retains these settings. After installation is complete, you can hand-configure these settings as well. To disable a function, set the registry value to “0.” Reset the value to “1” to re-enable the function. Each key is of the type **REG_DWORD**.
### Table 11: Configuring Functions from the Registry

<table>
<thead>
<tr>
<th>Functions</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Macro Support</strong></td>
<td>The registry key is MacroUiEnabled.</td>
</tr>
<tr>
<td></td>
<td>Example: HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\15\Settings &quot;MacroUiEnabled&quot; (0)</td>
</tr>
<tr>
<td><strong>Internet Access</strong></td>
<td>The registry key is InternetConnectionEnabled.</td>
</tr>
<tr>
<td></td>
<td>Example: HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\15\Settings &quot;InternetConnectionEnabled&quot; (0)</td>
</tr>
<tr>
<td><strong>Online Help</strong></td>
<td>The registry key is OnlineHelpEnabled.</td>
</tr>
<tr>
<td></td>
<td>Example: HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\15\Settings &quot;OnlineHelpEnabled&quot; (1)</td>
</tr>
<tr>
<td><strong>UI Customization</strong></td>
<td>The registry key is EnableUserCustomization.</td>
</tr>
<tr>
<td></td>
<td>Example: HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\15\Settings &quot;EnableUserCustomization&quot; (1)</td>
</tr>
<tr>
<td><strong>Catalyst Access</strong></td>
<td>The registry key is ConnectEnabled.</td>
</tr>
<tr>
<td></td>
<td>Example: HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings &quot;ConnectEnabled&quot; (0)</td>
</tr>
<tr>
<td>Note: Catalyst is turned off by default in version 10.0</td>
<td></td>
</tr>
<tr>
<td><strong>Connect Access</strong></td>
<td>The registry key is Connect3Enabled.</td>
</tr>
<tr>
<td></td>
<td>Example: HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings &quot;Connect3Enabled&quot; (1)</td>
</tr>
<tr>
<td>Note: Connect is turned on by default in version 10.0, and this key must be entered manually.</td>
<td></td>
</tr>
<tr>
<td><strong>Disable Attachments</strong></td>
<td>The registry key is DisableAttachments.</td>
</tr>
<tr>
<td></td>
<td>Example: HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings &quot;DisableAttachments&quot; (1)</td>
</tr>
<tr>
<td><strong>Effort</strong></td>
<td>The registry key is ShowEffort.</td>
</tr>
<tr>
<td></td>
<td>Example: HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings\ShowEffort</td>
</tr>
<tr>
<td>Note: Set dword to either 0 or 1 during an LSD (or setup.exe) installation.</td>
<td></td>
</tr>
</tbody>
</table>
### Functions

<table>
<thead>
<tr>
<th>Functions</th>
<th>Examples</th>
</tr>
</thead>
</table>
| License Key     | The registry key is License Key.  
Example:  
HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Registration  
**Note**: Use .reg script to set the key via ISX_SERIALNUM deployment. |
| Online Files    | The registry key is Connect3ApiEnabled  
Example:  
HKEY_CURRENT_USER\Software\Mindjet\MindManager\15\Settings\Connect3ApiEnabled  
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Mindjet\MindManager\15\Settings\Connect3ApiEnabled  
**Note**: Adds ‘Let add-ins use online features’ checkbox to Add-Ins tab of Options dialog. |

### Deploying User Data and the Library

As discussed previously in *Deploying User Data and the Library to a Server* (page 20), you may want to deploy user data and the library to a server. If you want to deploy the user data and library on separate servers, you must do so from the command line or by editing the registry.

### Deploying User Data and the Library from the Command Line

The following commands give you the ability to deploy user data and the Library to separate locations. Each option consists of a property, which (when given a command line value) writes to the registry. You can also predefine these options by creating and executing a registry script before a silent setup.

### Table 12: User Data Deployment Options

<table>
<thead>
<tr>
<th>Command</th>
<th>Resulting Registry Entry</th>
</tr>
</thead>
<tbody>
<tr>
<td>USERDATAPATH=&quot;&lt;user specified path&gt;&quot;</td>
<td>HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\14\Installer &quot;LSDUserDataPath&quot; &quot;&lt;user specified path&gt;&quot;</td>
</tr>
<tr>
<td>USERDATAPERUSERPATH=&quot;1&quot;</td>
<td>Deploy user data in a per-user folder.</td>
</tr>
<tr>
<td></td>
<td>1=Enable</td>
</tr>
<tr>
<td></td>
<td>0=Default or disable</td>
</tr>
<tr>
<td>USERDATAPATHSUFFIX=&quot;&lt;user specified path&gt;&quot;</td>
<td>HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\15\Installer &quot;LSDUserDataPerUser&quot; (1)</td>
</tr>
<tr>
<td></td>
<td>This folder is appended to the per-user folder.</td>
</tr>
<tr>
<td></td>
<td>HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\15\Installer &quot;LSDUserDataPathSuffix&quot; &quot;&lt;user specified directory&gt;&quot;</td>
</tr>
</tbody>
</table>
Example:

```
msiexec /i "Mindjet Admin.msi" USERDATAPATH="C:\Temp\UserData"
USERDATAPERUSERPATH="1" USERDATAPATHSUFFIX="MyUserData"
```

Table 13: Library Deployment Options

<table>
<thead>
<tr>
<th>COMMAND</th>
<th>RESULTING REGISTRY ENTRY</th>
</tr>
</thead>
<tbody>
<tr>
<td>LIBRARIESPATH=&quot;&lt;user specified path&gt;&quot;</td>
<td>HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\15\Installer &quot;LSDLibraryPath&quot; &quot;&lt;user specified path&gt;&quot;</td>
</tr>
<tr>
<td>LIBRARIESPERUSERPATH=&quot;1&quot;</td>
<td>Deploy libraries in a per-user folder.</td>
</tr>
<tr>
<td></td>
<td>1=Enable</td>
</tr>
<tr>
<td></td>
<td>0=Disable</td>
</tr>
<tr>
<td>LIBRARIESPATHSUFFIX=&quot;&lt;user specified directory&gt;&quot;</td>
<td>HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\15\Installer &quot;LSDLibraryPerUser&quot; (1)</td>
</tr>
<tr>
<td>LIBRARIESEXTRACT=&quot;1&quot;</td>
<td>Extract libraries to path the first time the application starts.</td>
</tr>
<tr>
<td></td>
<td>1=Enable</td>
</tr>
<tr>
<td></td>
<td>0=Disable</td>
</tr>
<tr>
<td></td>
<td>HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\15\Installer &quot;LSDLibraryExtract&quot; (1)</td>
</tr>
</tbody>
</table>

Example:

```
msiexec /i "Mindjet Admin.msi" LIBRARIESPATH="C:\Temp\Libraries"
LIBRARIESPERUSERPATH="1" LIBRARIESPATHSUFFIX="MyLibraries"
LIBRARIESEXTRACT="1"
```

Deploying User Data from the Registry

During a silent (non-interactive) installation, you can deploy data user files by setting some registry values on the user's system in the registry key before running the installer:

```
HKEY_LOCAL_MACHINE\Software\Mindjet\MindManager\15\Installer
```

Table 14: User Data Registry Key Values

<table>
<thead>
<tr>
<th>REGISTRY VALUE</th>
<th>DATA VALUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>LSDUserDataPath</td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>N:\User Data\All Users\Mindjet\MindManager\</td>
</tr>
<tr>
<td></td>
<td>or</td>
</tr>
</tbody>
</table>
If you want to deploy all of the user data (including the library) on a server, create a registry file named “MindManager Large-Scale Deployment Options.reg” like this:

```
REGEDIT4
[HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet]
[HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager]
[HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15]
[HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Installer]
"LSDUserDataPath"="N:\User Data\All Users\Mindjet\MindManager 15"
"LSDUserDataPerUser"=dword:00000001
"LSDUserDataPathSuffix"="User Data"
LSDLibraryPath= N:\All Users\Mindjet\MindManager 15
"LSDLibraryPerUser"=dword:00000001
"LSDLibraryPathSuffix"="Library"
"LSDLibraryExtract"=dword:00000001
```

Sample Setup Commands

The following sections provide sample commands to demonstrate various installation scenarios.

Simple Installation

This command simply runs the installer in the usual interactive mode.

```
Msiexec.exe /i "Mindjet Admin.msi"
```

You can also run `MindManager Admin.msi` from Windows Explorer.

Silent Installation

This command silently runs the installer, supplying values for all required parameters.

```
Msiexec.exe /i "MindManager Admin.msi" /qn INSTALLDIR="C:\Program Files\Mindjet\MindManager 15" ISX_SERIALNUM="MPxM-MM1-xxxx-xxxx-xxxx"
```
Note that the "xxxx-xxxx-xxxx-xxxx-xxxx" portion of the license key must be replaced with a valid key. Optional parameters are USERNAME and COMPANYNAME.

Sample Customized Installation Using ADDLOCAL and REMOVE

Here is an example for a customized silent install, using ADDLOCAL and REMOVE:

```
Msiexec.exe /i "Mindjet Admin.msi" /qn /L*v "C:\MM15AdminSetup.log"
INSTALLDIR="D:\Program Files\Mindjet\MindManager 15" ISX_SERIALNUM="MPxM-MM1-
xxxx-xxxx-xxxx-xxxx" USERNAME="John Doe" COMPANYNAME="Acme, Inc."
ADDLOCAL="ALL" REMOVE="MMPlayerExport, MSWordAddin" MACROUI="0"
INTERNETACCESS="0" UICUSTOMIZATION="0" ONLINEHELP="0"
```

Silent install options for the MMPlayerExport key that supports the Viewer feature are available and supported using Admin .MSI package.

To remove the feature:

```
msiexec /i PATH_TO.msi ADDLOCAL="ALL" REMOVE="MMPlayerExport" /qn
```

To re-instate the feature:

```
msiexec /i PATH_TO.msi ADDLOCAL="MMPlayerExport" /qn
```

Uninstallation

This command uninstalls the application:

```
Msiexec.exe /x "MindManager Admin.msi"
```
Deploying with Active Directory

Deploying via Active Directory and Group policies is has limited supported at this time because:

- The setup only supports computer-based software installation
- Some properties can only be configured from the command line

You can use configuration tools such as Orca to:

- Configure properties from the property table
- Save the settings to a transform file (MST)
- Deploy it with the updated values

Here is a list of properties you can modify in the Property Table:

Table 15: Properties Editable in Properties Table

<table>
<thead>
<tr>
<th>PROPERTY</th>
<th>DESCRIPTION/DEFAULT SETTING</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTERNETACCESS=1/0</td>
<td>Allow internet access</td>
</tr>
<tr>
<td></td>
<td>Default=1</td>
</tr>
<tr>
<td>ISX_SERIALNUM</td>
<td>Specifies a license key to activate the product. Add to the properties table in the .mst file with the license key as the value.</td>
</tr>
<tr>
<td>LIBRARIESPATH=&lt;defaultpath&gt;</td>
<td>User can override default path.</td>
</tr>
<tr>
<td>LIBRARIESPATHSUFFIX=&lt;defaultpath&gt;</td>
<td>User can override default path.</td>
</tr>
<tr>
<td>LIBRARIESPERUSERPATH=0/1</td>
<td>Deploy libraries per user</td>
</tr>
<tr>
<td></td>
<td>Default=0</td>
</tr>
<tr>
<td>LIBRARIESEXTRACT=1/0</td>
<td>Extracts libraries at first launch</td>
</tr>
<tr>
<td></td>
<td>Default=1</td>
</tr>
<tr>
<td>USERDATAPATH=&lt;defaultpath&gt;</td>
<td>User can override default path.</td>
</tr>
<tr>
<td>USERDATAPATHSUFFIX=&lt;defaultpath&gt;</td>
<td>User can override default path.</td>
</tr>
<tr>
<td>USERDATAPERUSERPATH=0/1</td>
<td>User Data deployed per user</td>
</tr>
<tr>
<td></td>
<td>Default=1</td>
</tr>
<tr>
<td>MACROUI=1/0</td>
<td>Enable Macros in UI</td>
</tr>
<tr>
<td></td>
<td>Default=1</td>
</tr>
<tr>
<td>ONLINEHELP=1/0</td>
<td>Enable online help</td>
</tr>
<tr>
<td></td>
<td>Default=1</td>
</tr>
<tr>
<td>REBOOTISREQUIRED=No/Yes</td>
<td>Require reboot after installation</td>
</tr>
<tr>
<td></td>
<td>Default=No</td>
</tr>
<tr>
<td>TOPICALERTSLINKER=1/0</td>
<td>Enable topic alerts linker</td>
</tr>
<tr>
<td>PROPERTY</td>
<td>DESCRIPTION/DEFAULT SETTING</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>UICUSTOMIZATION=1/0 (default=1)</td>
<td>Default=1</td>
</tr>
<tr>
<td></td>
<td>Enable UI customization</td>
</tr>
<tr>
<td></td>
<td>Default=1</td>
</tr>
<tr>
<td>SHORTCUTDESKTOP=1/0 (default=1)</td>
<td>Create Desktop shortcut</td>
</tr>
<tr>
<td></td>
<td>Default=1</td>
</tr>
<tr>
<td>SHORTCUTQUICKLAUNCH=1/0</td>
<td>Create QuickLaunch shortcut</td>
</tr>
<tr>
<td></td>
<td>Default=1</td>
</tr>
<tr>
<td>SHORTCUTSTARTMENU=1/0 (default=1)</td>
<td>Create StartMenu shortcut</td>
</tr>
<tr>
<td></td>
<td>Default=1</td>
</tr>
</tbody>
</table>

Recommendations include
- Saving these settings to the transform file as a backup, rather than directly to the MSI
- Deploying on a per-machine basis only, avoiding the possibility that the machines with multiple users get multiple copies of the application installed
- Creating a policy for “Always install elevated,” otherwise the installation may fail
DEPLOYING WITH WINDOWS SERVER

You can install with Windows Server 2003 running Terminal Services, and then deploy it to variety of client machines.

To install on a Windows Server 2003 running Windows Terminal Services (WTS):

1. Log on to the Windows Terminal Server as an administrator.
2. Launch Admin.msi.
3. We recommend using the Add/Remove Programs applet in the Windows Control Panel.
4. Avoid running the installer directly from Windows Explorer unless you are familiar with using the "change user /install" and "change user /execute" commands.
5. Select Add New Programs and then select CD.

**The automatic procedure does not find the setup program.**

6. For the Run Installation Program dialog, click Browse.

In the Browse dialog:
7. Change Files of type to Programs.
8. Navigate to the installer location.
10. Click **Open** and then **Next** to start the installer.
11. In the Customer Information dialog, leave the User Name blank or chose a "generic" name.

The user can customize this by entering an Organization name and the License Key.

12. In the Setup Type dialog, choose Complete or Custom as desired.

For details about customization, see **Deploying with the Installation Wizard** (page 18).

13. Complete the installation as outlined in **Completing the Installation** (page 22).

14. Please make sure to finish the Admin Install wizard of the Windows Terminal Server by clicking the Finish or Cancel button. **Note: DO NOT START THE APPLICATION BEFORE THIS DIALOG IS FINISHED!**

You can now run on the server with the Windows Remote Desktop Connection client.

The application runs in full color mode and does not support 256-color mode. For best results, run the terminal server clients in full color mode as well. Deploying under Windows 2000 server will function, but with less than optimal results.
DEPLOYING WITH CITRIX PRESENTATION SERVER

The Citrix MetaFrame Presentation Server is a sophisticated terminal server environment built on top of the Windows Terminal Services provided by Windows Server. This is currently the only tested and supported Citrix platform, though other combinations may also behave properly.

Basic Installation for the Citrix Desktop

For better Citrix performance, do not install the application on a C: drive. After installation, MindManager appears as part of the Citrix Desktop—a single window containing icons for all the published applications.

Advanced Installation of a “Seamless” Window

You can also install to Citrix as a seamless individual application window, instead of installing as part of the Citrix desktop, as described above.

To install as a seamless individual application window:

1. Install on a Windows Server 2003 running Windows Terminal Services (WTS)
2. Click the Presentation Server Console button  from the Citrix toolbar.
3. Log on to the server.
4. In the tree, select Applications.
5. Right-click Applications.

7. Specify what to publish.
8. Define the Program Neighborhood Settings.

9. Define the Application Appearance options. (Set to High Color or True Color).

10. Specify special client requirements. (Default settings are fine).
11. Specify the number of licenses you have purchased in the “Maximum instances” field.

12. Specify which servers will deploy.

13. Specify users. (We recommend doing this by group, to ease the load of adding single users).
14. Leave the File Type Associations page empty; the application is registered on the server.

Once you have completed the installation, you should see the MindManager in the Applications section:

The application icon now appears in authorized users' Citrix 3.x Program Neighborhood or in XenApp
For more configuration options, please consult your Citrix documentation.
ADMINISTERING MINDMANAGER

There are other administrative issues involved in deploying on a large scale. You can address many of them using the administrative tools and methods described below.

Managing Add-Ins

The application uses a number of add-in DLLs. The Add-Ins are automatically registered when the application is installed. On startup, the Add-Ins check for any other required resources (e.g. the supported version(s) of Microsoft Word). They enable or disable themselves as appropriate. If an add-in fails to start, it is automatically removed from the list of add-ins (but not from the disk).

Registering or Unregistering Add-Ins from the Command Line

To unregister the Word add-in:

1. Select Start>Run.
2. Enter the command:
   
   regsvr32 /u "C:\Program Files\Mindjet\MindManager 15\Mm10Word.dll"
3. To restore an unregistered add-in, for example the Word Add-in, 
4. Select Start>Run.
5. Enter the command:
   
   regsvr32 "C:\Program Files\Mindjet\MindManager 15\Mm10Word.dll"

Managing Add-Ins from the Registry

Users can enable and disable Add-ins via the Tools > Add-Ins command. However, if desired it is possible to disable or remove individual add-ins via the Windows Registry.

The Registry Add-In List

The list of add-ins that load at startup can be found in the Registry at:

   HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\AddIns

Removing or Restoring Add-Ins from the Registry

To remove an add-in (i.e. make it “invisible” to the application), delete its registry subkey.

To remove the Word add-in, delete the following key:
This makes the add-in “invisible” to the application so it will not be loaded on program startup and will not be seen in the list of add-ins in the Tools -> Add-Ins dialog. However, the add-in DLL files still exist on the hard drive.

Another way to remove an add-in is to unregister it as described in Registering or Unregistering Add-Ins from the Command Line (page 43). We do not recommend deleting the add-ins DLLs since they will be restored automatically the next time the program is run via its shortcut.

**Enabling or Disabling Add-Ins from the Registry**

Users can disable or enable a given add-in directly via the Tools -> Add-Ins command. Add-ins can also be disabled via the Windows Registry as described below.

There are two keys to consider when disabling an add-in for a given user:

- **HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\AddIns\AddInName**
- **HKEY_CURRENT_USER\SOFTWARE\Mindjet\MindManager\15\AddIns\AddInName**

where **AddInName** is the actual name of the add-in (e.g. Mindjet.Mm15Word.AddIn.x).

When a given user starts the application, the program checks first in the HKEY_CURRENT_USER subkey for a “LoadBehavior” value. If it exists, it is used.

If the “LoadBehavior” value does not exist, the application copies the LoadBehavior value from the HKEY_LOCAL_MACHINE subkey to the HKEY_CURRENT_USER subkey and then uses that value.

Therefore, to disable an add-in for the current user, set the LoadBehavior value in the HKEY_CURRENT_USER subkey to 0.

To disable the add-in for all new users, set the LoadBehavior value in the HKEY_LOCAL_MACHINE subkey to 0.

**Note:** This has no effect on users that have already run the application at least once. For them you must set LoadBehavior in the HKEY_CURRENT_USER subkey.

Similarly, setting LoadBehavior to 2 enables the add-in again.

**Managing Microsoft Office Add-Ins**

When the application is installed, it registers add-ins for MS Office products. The location of this add-in registration in the Windows Registry depends on the application and the add-in.

For example, the add-in for Microsoft Word is registered on a per-machine basis (so all users of the machine have it) at:

- **HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\Word\Addins\Mindjet.Mm15Word.AddIn.x**

Note that Word handles the Tools -> "COM Add-Ins" command and user interface differently than MindManager.

- In Word, if an add-in is registered in HKEY_LOCAL_MACHINE (HKLM), then it is not displayed in the COM Add-Ins dialog.
- If an add-in is registered in HKEY_CURRENT_USER (HKCU), it is displayed in the dialog and can be turned off and on.
If the add-in is registered both in HKLM and HKCU, Word ignores the HKCU entry and just uses the HKLM entry.

The registry data values for the Microsoft program add-ins are the same as described for the add-ins, and can be edited in a similar fashion.

Managing from the Registry

To allow system administrators to control the environment presented to their users, the application supports registry settings, which can be set via the user interface. However, registry settings relevant to Large-Scale Deployment are not available from this user interface. See also the user data installation options on page 5, which are similarly adjusted via registry settings.

HKEY_LOCAL_MACHINE Settings

The following registry settings are used on a per-machine basis:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Registration

Table 16: HKEY_LOCAL_MACHINE Registration Values

<table>
<thead>
<tr>
<th>VALUE_NAME</th>
<th>TYPE</th>
<th>VALUE DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>ShowLicense</td>
<td>REG_DWORD</td>
<td>0 to not show the license key being used or allow it to be changed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 to show the license key</td>
</tr>
<tr>
<td>ChangeLicense</td>
<td>REG_DWORD</td>
<td>0 to prevent changing the license key.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 to allow the license key to be changed.</td>
</tr>
</tbody>
</table>

The following registry settings are used on a per-machine basis:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings

Table 17: HKEY_LOCAL_MACHINE Settings

<table>
<thead>
<tr>
<th>VALUE_NAME</th>
<th>TYPE</th>
<th>VALUE DATA</th>
</tr>
</thead>
<tbody>
<tr>
<td>LocalUserDataDirectory</td>
<td>REG_SZ</td>
<td>Path to copy user data files (e.g. Image Library files, etc.) at first launch. May contain environment variables.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%USERPROFILE\Local Settings\Application Data\MindManager\15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If no path is specified, then this path is assumed:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%USERPROFILE%\MindManager 15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>This setting can be overridden by the same setting in HKEY_CURRENT_USER (see below) or by the LSDUserDataPath setting described.</td>
</tr>
<tr>
<td><strong>VALUE NAME</strong></td>
<td><strong>TYPE</strong></td>
<td><strong>VALUE DATA</strong></td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PerUserInstallation</td>
<td>REG_DWORD</td>
<td>0 for per-machine license key management. 1 for per-user license key management.</td>
</tr>
<tr>
<td>EnableTellAFriend</td>
<td>REG_DWORD</td>
<td>0 to never show the Tell a Friend dialog.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: Not included with default installation, and can be set in either HKLM or HKCU</td>
</tr>
</tbody>
</table>

### HKEY_CURRENT_USER Settings

The following registry settings are used on a per-user basis:

**HKEY_CURRENT_USER\SOFTWARE\Mindjet\MindManager\15\Settings**

#### Table 18: HKEY_CURRENT_USER Settings

| **VALUE NAME**         | **TYPE** | **VALUE DATA**                                                                                                                                                                                                 |
|------------------------|----------|------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------……………|
Managing with Event Macros

The application can trigger certain Event Macros that can help system administrators monitor the usage of the program more carefully.

- These macros are examples only. You need to customize them for your environment.
- Microsoft added the Outlook Object Model Guard starting with Outlook version 2002, forcing the display of an alert message informing the user that a program is trying to access or send a message via Outlook, which the user must approve before proceeding. This behavior can be controlled by Outlook system policies.

Table 19: Event Macros

<table>
<thead>
<tr>
<th>EVENT NAME</th>
<th>WHEN FIRED</th>
</tr>
</thead>
<tbody>
<tr>
<td>OnApplicationStarted</td>
<td>At the end of InitInstance (only when started in “normal” mode, not /RegServer, /UnregServer, etc.)</td>
</tr>
<tr>
<td>OnExpiredTrialStarted</td>
<td>Just before the “Trial Expired” dialog</td>
</tr>
<tr>
<td>OnFirstUse</td>
<td>Just before installation of “per-user data”</td>
</tr>
<tr>
<td>OnBuyButtonPressed</td>
<td>Just before the “Buy MindManager” dialog is displayed</td>
</tr>
</tbody>
</table>

When a macro event is fired, 0 or more macros are run. The mapping of macro event names to macro filenames is determined on startup.

On startup, the application looks in the registry at HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager15 for a key named Event Macros. If it is found, expect to find keys such as these:

```
Event Macros\
  OnApplicationStarted\
    EventMacro_OnApplicationStarted.mmbas
    EventMacro_OnApplicationStartedTwo.mmbas

Path="C:\Temp\EventMacro_OnApplicationStartedTwo.mmbas"
```

```
OnBuyButtonPressed\
  EventMacro_OnBuyButtonPressed.mmbas
OnExpiredTrialStarted\n  EventMacro_OnExpiredTrialStarted.mmbas
OnFirstUse\n  EventMacro_OnFirstUse.mmbas
```

Each event key can have 0 or more macro key names. Each macro key can have an optional “Path” value.

- If the “Path” value is not there, then the key name is the path.
- If the path is a relative path (e.g. "EventMacro_OnApplicationStarted.mmbas"), it is converted to an absolute path relative to the default macro folder for the user (e.g. "C:\Documents and Settings\UserName\Local Settings\Application Data\Mindjet\MindManager15\macros").
If the “Event Macros” key is not in the registry, then the application looks for event macros in the default macro folder (see above) with a name of the form:

    EventMacro_<EventName>.mmbas

For example:

    EventMacro_OnApplicationStarted.mmbas

Therefore, it is possible to get macro events to run a macro simply by putting macros with the proper name in the user's macro folder. However, for most typical IT uses, the “Event Macros” key will be used, since this can point to macros on a network drive, for example.

For example, this "EventMacro_OnApplicationStarted.mmbas" macro uses the Outlook object model to send a notification email:

    '#Uses "EventMacro_Utilities.mmbas"
    Sub Main
        SendNotificationEmail "MindManager event: Application Started"
    End Sub

Where the “EventMacro_Utilities.mmbas” file contains:

    ' Utilities for use with MindManager event macros

    Public Sub SendNotificationEmail(eventString As String)
        ' Sends the subject string to the appropriate IT person
        ' to notify them of the MindManager event that just occurred

        ' Get access to our email program
        Dim outlookApp As Outlook.Application
        Set outlookApp = New Outlook.Application

        ' Create a message
        Dim message As Outlook.MailItem
        Set message = outlookApp.CreateItem(olMailItem)
        message.To = "System Administrator"
        message.Subject = eventString
        message.Body = eventString

        ' Send the message
        message.Send
    End Sub
Managing User Licenses

Each user must have a license. Please contact your reseller or Mindjet sales representative for licensing terms appropriate for Large-Scale Deployment. MindManager does not include any special support for proprietary third-party license management software.

MindManager can check and administer license keys on a per-user or per-machine basis. The application first looks for a license key in:

\HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Registration\n
The default installation administers license keys on a per-machine basis. A license key can be entered after the program is installed, and all users of that machine have access to the program via that key.

To achieve per-user license key administration:

1. Install with no license key: use the installation wizard (which does not ask for a key), or use command-line installation without specifying a license key.
   
   Or, set the registry key:
   \HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings\PerUserInstallation\n
   to 1 after installation. This setting instructs the application to save any license key the user enters to the HKCU setting instead of the HKLM setting.

2. The administrator should put the user's license key in the user's HKCU registry setting (above)—or provide the user with the license key so s/he can enter it in the license key dialog that is automatically displayed upon launching in Trial mode.

Policies Support

The application does not offer official Windows Policies support.

MindManager Linker for SharePoint

**Note:** To use MindManager with Microsoft SharePoint, you must purchase and install MindManager Enterprise, which includes MindManager Linker for SharePoint.

MindManager Linker for SharePoint supports an optional silent argument for deploying a SharePoint SITECONNECTIONFILE as a way to pre-populate custom SharePoint connections.

Optional silent install argument:

```
SITECONNECTIONFILE=full_path_to_custom_site_connection_file
```

This file can have any name but must be reachable from install-to machine. The file is copied to “SiteConnections.xml” in the SharePoint Linker INSTALLDIR.

**Note:** This argument will have no operational effect when the application runs if the SharePoint Add-In is not active.

Proxy Server Support

The application supports proxy server connections to the internet, including overriding default Microsoft Internet Explorer settings.
Primary path:
1. Select Proxy Settings from MindManager → File → Options.
2. Choose Auto-detect/Use system proxy settings (e.g. set by system or w/in IE) or Manual proxy configuration (no proxy, https).

Alternate path:
1. System administrator sets proxy settings (Host & Port) for Large-Scale Deployment.
2. When installed, MindManager options are configured based upon on System Administrator user’s configuration.
3. System Administrator has an option to hide the ability to remember Username and Password for the HTTPS proxy settings.

Impacted areas:
* Online (Files) - New/From Maps for that Gallery, Signin/out, and Tasks.
* Notifications; Creating/deleting files; folders, Co-editing and Sharing.
* Trial display messages emanating from Mindjet servers.
* Tasks
* Connection – sign in/sign out
* Design partner
* Check for updates
* All the web services Map Parts
* SharePoint Add-in *
* Database linker
* To use MindManager with Microsoft SharePoint, you must purchase and install MindManager Enterprise.

The registry settings are as follows:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings\ProxyType = 0 (no proxy) - DWORD type
1 = Use default windows settings
2 = Use custom proxy settings

In case your proxy type is set to custom, you can set a custom proxy as follows:

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings\ProxyHost = host name - STRING

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings\ProxyPort = port name - DWORD

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings\ProxyAuthenticationRequired - DWORD (can be 0 or 1)

HKEY_LOCAL_MACHINE\SOFTWARE\Mindjet\MindManager\15\Settings\ProxySaveCredentials - DWORD (can be 0 or 1) - is used to save proxy credentials across application sessions
INDEX

Active Directory
- Deploying MindManager with, 34

Add-Ins
- Configuring from the command line with msi.exe, 26
- Disabling, 43
- Disabling from the registry, 44
- Enabling from the registry, 44
- Microsoft Office Add-ins, 26, 44
- Registering, 43
- Registry keys, 9
- Removing via the Registry, 43
- Restoring via the Registry, 43
- Unregistering, 43

Admin Setup
- Comparing benefits vs. standard setup, 2, 16
- Contents of admin setup zip file, 14

Citrix MetaFrame Presentation Server
- Deploying MindManager with, 1
- Deploying MindManager from the command line, 24
- Deploying MindManager with Active Directory, 3
- Citrix MetaFrame Presentation Server, 3, 37
- Windows Server, 36

Dictionaries
- Overview, 5

Event Macros
- Administering MindManager with, 47

Installation
- Comparing per-machine and per-user setup, 16
- Components, 4
- From the command line, 24
- Using the installation wizard, 18
- With Active Directory, 34
- With Citrix MetaFrame Presentation Server, 37
- with Windows Server, 36

Library
- Contents, 26
- Deploying to a separate server from the command line, 30
- Deploying to a separate server using the installation wizard, 20
- HKEY_LOCAL_MACHINE settings, 45
- HKEY_CURRENT_USER settings, 46
- Overview, 4

MindManager
- Third party software, 7

Orca
- Editing the Properties Table with, 34

Registry Keys
- Administering MindManager with, 45
- Configuring MindManager from the registry, 28
- Deploying the library and user data with, 30
- Managing add-ins with, 43
- Overview, 9

Shortcuts, 6
- Configuring from the command line, 28
- Editing on the Properties Table with Orca, 35

Silent Installation
- Sample command line silent installation, 32

Start Menu Item, 6

System Requirements, 1

Third Party Software, 7

Tutorials
- Overview, 5

Uninstallation
- Overview, 12
- Registry Keys, 13

User Configuration Files, 5

User Data
- Deploying to a separate server from the command line, 30
- Deploying to a separate server using the installation wizard, 20
- Deploying with registry keys, 31
- Editing on the Properties Table with Orca, 34
- HKEY_CURRENT_USER settings, 46
- HKEY_LOCAL_MACHINE settings, 45

User Licenses
- Managing, 49
The material in this document is for informational purposes only and is subject to change without notice. While reasonable efforts have been made in the preparation of this document to assure its accuracy, Mindjet makes no representation or warranty expressed, implied, or statutory, as to its completeness, accuracy, or suitability, and assumes no liability from the use of the information contained herein.

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by patent, copyright, trademark, and other intellectual property laws. Except as expressly provided in any written license agreement from Mindjet, the furnishing of this document does not give you any license to these patents, copyrights, trademarks, or other intellectual property.

Mindjet, MindManager, and the Mindjet and MindManager logos are trademarks of Mindjet, which may be registered in the U.S. and other countries. Microsoft and SharePoint are registered trademarks of Microsoft Corporation in the United States and other countries.

Mindjet, MindManager, and the Mindjet and MindManager logos are trademarks of Mindjet, which may be registered in the U.S. and other countries. Citrix and XenApp are trademarks of Citrix Systems, Inc. registered in the US and other countries. IBM is a trademark of International Business Machines Corporation registered in the US and other countries. Adobe Flash and Adobe Acrobat are registered trademarks of Adobe Systems Incorporated in the United States and other countries.

© 2014 Mindjet. All rights reserved.